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Getting Started

If you are already a registered user of IMPA, log into IMPA as you normally would.

If you are not a registered user of IMPA, go to https://secureapp.dhs.state.ia.us/impa/

and choose: Click here for the User Registration Guide:

Iowa Medicaid iy =
Portal Access “

| Register New Account Documents

Welcome to the Iowa Medicaid Portal Application!

Click here for the
User Registration Guide

« ICD-10 is coming. Are you ready? Registration for the IME
ICD-10 Volunteer Testing is now open. To register for testing,
please contact the IME Provider Services Unit at 1-800-338-
7909, or locally in Des Moines at 515-256-4609 or by email at
ICD-10project@dhs.state.ia.us

« The Centers for Medicare and Medicaid (CMS) published the
QOutpatient Prospective Payment System (OPPS) Final Rule

G0463 (Hospital cutpatient clinic visit for assessment and
management of a patient) for hospital use only. The new
HMPOS rade will ha ranracantative nf anv clinic vicit indar tha

Looking for a medicaid participating provder? Find one here,

Be sure to find all of the latest Provider Information Letters here.

Nov. 27, 2013, established a new alphanumeric HCPCS code,

Halpful Hints

User Name:

Password:
Medicaid in the news
likely to survive if readmitted to the same hospital (7 Legln
hours ago) Repet Accoynt
Patients rehospitalized with complications after major
surgery are 26% more likely to survive if the...

't save money for
Medicare (Yesterday)

Researchers conclude that Medicare Part D did not save
the (Medicare) program any money overallFor...

Medi for
(6/9/201S)
Millions of seniors with Medicare Advantage plans,

including more than a million with low incomes, w...

= : itals mark up costs
by 1,0009% (6/9/2015)

Each person logging into an application within IMPA must create their own IMPA account. At the
top of the left hand corner under lowa Medicaid Portal Access is a link to Register New Account.

Create a username and password for each user that will complete reenroliment or the OCD
application within IMPA. The user name is not case sensitive but the password must be 8
characters (one lowercase letter, one uppercase letter, a symbol and a number).

Log into IMPA with the user name and password created. Click on “I Accept to Enter the

System.”
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Claim a Personal Identification Number (PIN)

You must claim a security PIN to access your reenroliment application or the OCD application.

Your Designated Contact Person (DCP) will have provided to you a PIN for accessing the
appropriate Tax ID (s). The user must “Claim PIN” before they can proceed to the Reenroliment

application or OCD application.

You only need to claim the PIN once.

Iowa Medicaid Y/
&
Portal Access "%; 4
File » Review ) Manage » Information » Messages Logout
- claim pIN
Claim PIN

Enter PIN
Tax ID:

PIN:

[ claim PIN

lewa Department of Human Services

Hoover over File, from the drop down click on “Claim PIN”.
Enter your “Tax ID” number and “PIN” and click on the button Claim PIN.

Once the PIN has been successfully claimed proceed to the application (reenroliment or OCD
application).

Reenrollment application:
Hover over File, and click on Reenroliment in the drop down.
OCD application:

Hover over Review, and click on OCD in the drop down.
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Roles

Reenrollment:

The reenrollment application may be entered by either the enroliment user or the signatory. The
enrollment user is not allowed to accept the provider agreement. Only the signatory is allowed
to accept the provider agreement. The user is required to have a PIN prior to starting the
reenrollment application.

There are two roles defined for users for the reenrollment application:

o Enrollment User- this role can update all sections except the agreement and
acceptance.

e Signatory User- this role can update all sections including the agreement and
acceptance.

The Tax ID and the application status will appear on each section.

OCD:

The OCD user role allows the creation of or update to an already completed OCD application.

Each Tax ID enrolled into the Medicaid Program is required to complete the OCD application
prior to enroliment.

Other Roles:

e Health Information Technology (HIT) - this user role allows the completion of the HIT
survey after reenroliment has been completed.
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Reenrollment Application

Providers are required to complete the reenrollment application process every five years, unless
otherwise required by applicable state and federal law. Reenrollment includes, but is not limited
to: legally accept the provider agreement, verify a listing that identifies each professional and
institutional component of your organization and structure, complete the OCD and collect
individual Social Security Numbers (SSN). The SSN is required in order for the IME to check
against the Office of Inspector General's (OIG) list of Excluded Individuals and Entities (LEIE)
and the Centers for Medicare and Medicaid Services (CMS) Medicare Exclusions Database
(MED). The individual SSN is required for screening purposes only. It does not pertain to claims
processing or payment.

To start the reenrollment process, simply complete and return the DCP form. A contact person
must be designated for the coordination of the provider reenrollment process (Form number
470-5112, can be found on the DHS website at: http://dhs.iowa.gov/ime/providers/forms).

Upon receipt of the DCP form, a unique PIN associated with the Tax Identification (ID) will be
assigned. The DCP will receive and email containing the PIN number (s).

Once you have logged into IMPA and have claimed PIN you are ready to get started.
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Start Reenrollment Application

Hover over File and select “Reenrollment.”

M v B 0 #m v Pagev Safetyr Took~

APA

Iowa Medicaid .
Good Morning

Portal Access

File » Review » Manige * [nformation » Messages Logout

Start/Edit/View Reenrollment Application(s)

Tax ID: [— -
Do you want to start Reenroliment [ Start

Towa Deparvmant of Hunan Services

Select the Tax ID from the drop down list.

The lists of Tax ID’s are based on the PIN (s) you have claimed.

If you do not see the appropriate Tax ID please contact your DCP.

M v B -0 #m v Pager Safetyw Took~

APA

Iowa Medicaid
Good Morning

Portal Access

File » Review » Manige ) Information » Messages Logout

Start/Edit/View Reenrollment Application(s)

Tax ID: -
Do you want to start Reenroliment &] ’

Towa Deparvmant of Hunan Services

Click on Start button

Note: If you have completed Reenroliment on IMPA in the past you will see a line in the grid
with a completed status and completion date.

Select the line with a status of ‘In Progress” to continue with this reenroliment.
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i MEdicaid - g : Good Morning Julbie Harding
| Portal Access' Wil 4 :
|E|l! » Review » Manige » [nformation » Messages Logout

Start/Edit/View Reenroliment Application(s)

Tax ID: 812 ~

812 32 InProgress Select

Iowa Decartmant of Human Services

Click on Select in the grid as shown above.

The initial page displayed is Check-Out Summary.

On the left side of the page are the navigation links (in blue, under Home).

This page will display:

e Tax ID Number.
e Application Status.
e Check-Out status.

fowa Medicaid
Portal Access WS
File » Review » Manage » |nformation » Messages Logout

Tax ID:
Application Status:

Good Afternoon

Home Check-Out Summary

Process Checkout/Checkin
1 Business Entity Management Tax ID:
2 Organizational Roster Management ~ CUTent Status: !
3 Rendering Roster Management
4 Ownership And Control Disclosure

Provider Type Checked-out
5 Health Information Technology Survey SSttiop e pas SRS Ehei
6 IME Documentation Verification Business Entity Management
7 t and Acc
8 Renewal Package Review Organizational Roster M

dering Roster g

Ownership and Control Disclosure
Health Information Technology Survey

Agreement and Acceptance

Revised 11/2022 Page 8



Process Check-out/Check-in

e Check-Out (Selected)

o Ifyou, as an Enrollment user can check-out any section except Agreement and

Acceptance, click on the Check-Out box next to the section and click “Check-Out
(Selected).

e Check-In (Selected)

o0 Atfter all required information has been entered click on check-in next to that
section and click the Check-In Selected button.

Iowa Medicaid
Portal Access

Tax ID: 812
Application Status: InProgress

Home Check-Out Summary
Process Checkout/Checkin
1 Busi Entity M. t Tax ID: 18312
2 Organizational Roster Management Current: Statiss: InPrograss
3 Rendering Roster Management Checked-in the selected processes successfully.

| Check-Out ALL J _Check-Out (Selected) Check-In ('Sele\:ted}'
5 Health Information Technology Survey
: IME Documentation Verification Checked-out
Agreement and Acceptance

Section Hame User eck-out Check-in
& Renewal Package Review
Business Entity Management

Organizational Roster Management th ! /
Rendering Roster Management
Ownership and Control Disclosure

Health Information Technology Survey

Agreement and Acceptance

Towa Daparcmant of Human Services

The purpose of Check-out and Check-in, allows multi users to be working on the same Tax ID.
When a user has a section checked out another user will not be able to work in the same
section until that user checks that section in.

For example:
User 1 has Check-out: Business Entity Management.
User 2 has Check-out: Organizational Roster Management.

User 1 cannot enter data in the Organizational Roster Management section when it is in a
checked out status by user 2.
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Section 1: Business Entity Management

The purpose of the Business Entity Management section is to define the entity defined for tax
purposes.

In the left navigation click on: 1. Business Entity Management.

You can either check out from the Process Check-out/Check-in page or Click the “Check Out for
Edit” button on the business Entity Management page.

lowa Medicaid (a o
Portal Access - ‘ Good Morning

Eile » Review » Manage » Information » Messages Logout

Tax ID: 812
Application Status: InProgress
auine Checkout/Checki Business Entity Manag Check-out History
1 Business Entity Management
2 Organizational Roster Management f [ Check In
3 Rendering Roster Management
4 Ownership And Control Disclosure
ider T Tax ID: 812
5 Health Information Technology Survey Current Status: InProgress
6 IME Documentation Verification uc -
Agreement and Acceptance
:
Renewal Package Review

B
[ stated

VLTI TR AN LLC - Limited Liability Company -

Save

Towa Department of Hunan Services

e 1099 Name: pre populated with 1099 Name on file. If there are multi names on file select
correct name from in the drop down. If the name (s) is not correct, please submit a new
W-9 form to the IME Provider Services Enroliment Unit.

e Enter Business Email.

e Enter Phone Number.

e Enter Fax Number.

e Enter Headquarter Address.

e Enter City, State, Zip.

¢ Ownership Type: Select the type of ownership from the drop down.

e Click on Save.

e Click on Check-In.
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Section 2: Organizational Roster Management

The purpose of the Organizational Roster Management is to confirm your organization’s
payment structure.

In the left navigation click on: 2. Organizational Roster Management.
This page will contain all of the payment/billing NPI's. You will need to confirm the

information related to each NPI. You will work through each NPI in the select NPl dropdown
list. As you complete each NPI, the dropdown list will have the status before the NPI.

I ——
Iowa Medicaid i - —
Portal Access = | od Afternodn

File » Review » Manage » Information » Messages Logout

Tax ID: 812

Home Organizational Roster Management Check-out History

Check In
3 Rendering Roster Management Tax ID: 812
4 Ownership And Control Disclosure Current Status: InProgress

0 NPi(s) information completed out of 1 NPI{s)

6 IME Documentation Verification SelectNPL: __._....12 »

7 and Acceptance

Renewal Package Review
B Spate License
Provider nse  Expiration
KPL Hame/Address Taxonomy  Type Humber Dats W confirmed Al

=12 |k 3336MO001X 1/1/z2018

‘Save Current Selsctions |

Towa Departmant of Human Services

e Select the NPI from the dropdown list. Review all the data in grid. Name, Address,
Taxonomy code, license number, license expiration date.
o Note: if enrolled under multiple addresses, each address will appear in the grid.
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Iowa Medicaid
Portal Access

Eile * Review *» Manage * Information * Messages Logout

Tax ID: 812
Application Status: InProgress

Home Organizational Roster Management Check-out History

1 Business Entity Management :
Check In
3 Bendering Roster Management Tax ID: 812
4 Ownership And Control Disclosure Current Status: InProgress
Provider Type ;
0 NPI(s] information completed out of 1 NPI(s).

6 IME Documentation Verification Select NPL: __ ___ .12 ~

NPE Hame/Address Taxenomy | Type  Wumier Date Il confirmed AN
=nmess1? |AGEISANEMRamatatT T n e 333640001% | =7 S5 |1/1/2018 <

| Save Current Selections \

Towa Departmant of Human Services

From the dropdown next to each row select from the dropdown:

Confirmed - indicates that the information for the NPI is accurate.

o TIP: If all the information in all the grids below is correct, you can select
Confirmed All and it will change the value to Confirmed for each address for that
NPI in the list.

e Confirmed with Address Change - indicates that there is a change in the address. This
will require an address change form to be completed and mailed to the IME. The
address change form will be available to print under step #6

e Request Termination - indicates that this particular NP1 is no longer practicing at this
address. Once the IME receives this information the provider will be terminated.

e Click on Save Current Sections- Once this is successfully saved the dropdown list will

move to the next NPI automatically. After completing an NPI it will move to the bottom of

the list with a completed status. All NPIs must be completed before the application can
be submitted.

IMPORTANT NOTE:

Any other changes to displayed data must be submitted in writing to the IME Provider Services
Enroliment Unit. The data displayed on IMPA will not change.

After all NPI's have been completed, click on Check In move to next section.
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Section 3: Rendering Roster Management

The purpose of the Rendering Roster Management is to confirm your organization’s treating
provider structure as known to the IME.

On the navigation to the left of the screen click on: 3. Rendering Roster Management.

If the Tax ID has no treating/rendering NPI associated with it, a message in red will appear on
the screen: “This Tax ID has no rendering providers required for enrollment renewal” No action
is needed.

Iowa Medicaid E_ ! / ,
Portal Access ﬁ‘; 4

lm»m»mmvmm»wmm

Tax ID: 812
Application Status: InProgress

Home Rendering Roster Management Check-out History

3 Rendering Roster Management o 1o; s
4 ownership And Control Disclosure Current Status: InProgress

6 IME Documentation Verification This Tax ID has no renderng providers required for enrollment renewal ‘r

7A t and Acceptance

& Renewal Package Review

This page will contain all of the rendering NPI's. You will need to confirm the information related
to each NPI. You will work through each NPI in the select NPI dropdown list. As you complete
each NPI the dropdown list will have the status before the NPI.
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e
fowa Medicaid EI “‘, P

Portal Access
IB&'M'M'W’MW

Tax ID: -
Application Status: InProgress

Home Rendering Roster Management Check-out History

Check Out for Edit |

4 Ownership And Contrel Disclosure Current Status:
5 ith Inf ion Tect 1 s 0 NPI(s) information completed out of 224 NPI{s).
6 IME Documentation Verification Select NPL: o - dijp—

8 Benewal Package Review SSN: |
SSN (Confirmation): [

Note: If you have more than one specialty per address, selecting Confirmed, Confirmed with Address Change or Terminate, will apply
to all specialties. If you have a change for one specialty, but not the other then select IME Review. This will notify IME Provider
Services that additional consideration is required to complete your enrollment renewal packet.
tate Licensa
Pravider anse  Expiration | Type
NPT Mane/Address Taxonomy Type {pmber Date Code
ALOASERAS LANSSS et 5 0305, |12/31/2014

Eowa Department of Human Services

e Select the NPI from the dropdown list. Review all the data in grid. Name, Address,
Taxonomy code, license number, license expiration date.
0 Note: if enrolled under multiple addresses, each address will appear in the grid.

From the dropdown next to each row select from the dropdown:

e Confirmed - indicates that the information for the NPI is accurate.

o TIP: If all the information in all the grids below is correct, you can select
Confirmed All and it will change the value to Confirmed for each address for that
NPI in the list.

e Confirmed with Address Change- indicates that there is a change in the address. This
will require and Address change form to be completed and sent to IME. The address
change form will be available to print under step #6

e Request Termination - indicates that this particular NP1 is no longer practicing at this
address. Once the IME receives this information the provider will be terminated.

e Enter the SSN that is tied to the selected NPI.

e Enter the SSN again for confirmation.

o0 The two SSNs must match before the NPI data can be saved.

e Click on Save Current Sections- Once this is successfully saved the dropdown list will
move to the next NPI automatically. After completing an NP1 it will move to the bottom of
the list with a completed status. All NPIs must be completed before the application can
be submitted. Click on check-in and move to next section.
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Section 4: Ownership and Control Disclosure (OCD)

The purpose of the OCD section is to meet Federal regulations implemented with the Patient
Protection and Affordable Care Act by the Centers for Medicare & Medicaid Services (CMS).

This section will require the user to gather information as opposed to review existing data. Not
all sections pertain to every entity, but due diligence and best efforts to obtain the data is highly
recommended and required for some sections.

In the navigation bar click on: 4 Ownership and Control Disclosure.

Iowa Medicaid g-—ﬂ«' ’
¥
Portal Access WML 4

[mrmimvw!mm

Tax ID: 312
Application Status: InProgress

Home oOwnership and Control Disclosure Check-out History

2 Organizational Roster Management Lheck1n
4 Ownership And Control Disclosure Tax ID: 812
Provider Type Current Status: InProgress
: /
7 Agreement and Acceptance Ready to Complete

Next

Towa Dapartmant of Human Sarvices

This page has a Ready to complete button. This button is to be used when you have completed
the required section and will only be enabled when the OCD is checked out.

e Click on Check-Out for Edit, if this has not already checked out. This will check out all
section of the OCD.
e Click on Provider Type in the left navigation under number 4
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Iowa Medicaid
Portal Access

Good Afterncor;

Tax ID: 812
Application InProgress
Home Ownership and Control Disclosure
Process Checkout/Chackin
1 Business Entity Management Fax Ip: o2
B Nam@: H7mnem e amemas srmm s im0
3 Rendering Roster Management i
4 Ownership And Control Disclosure  Provider Type
Pursuant to 42 C.F.R. sections 455.104 through 455.106, providers applying for Medicaid must disclose certain information about
5 Health Information Technology SUrveY those who have a sufficient ownership interest in the provider as well s those who act as managers or agents of the provider. The
& IME Documentation Verification following series of questions seeks the necessary information to comply with these regulations.
7 agreement and Acceptance
8 Renewal Package Review It is the provider's resp ility to ensure all inf s accurate and to report any changes immediately by completing a new

Ownership and Disclosure form. See Section 1.6 and Section 3 of the Provider Agreement. Only one form is required per Tax
Identification Number (TIN) or Social Security Number (SSN). In the questions that follow, the Provider listed above is referred to as
"You" or "Your."

Are you an individual practitioner or a group of individual practitioners?

Individual Practitioner: [ Yes or [INo
Group of Individual Practitioners: [|ves or [INo

Not apphcable (N/A) - T sttest that the information submitted is accurate and complete and that I have read this entire section
before submitting. ||
Next

Towa Department of Human Services

Remember that the answer to these questions are legally binding; hence the attestation on each

page.

In the instructions below all sections will be covered, but might not be required br all.

Revised 11/2022
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Managing Employees

Federal regulations require that Medicaid agencies require providers to submit information
about managing employees. The term "managing employees" means a general manager,
business manager, administrator, director or board member, or other individuals who exercise
operational or managerial control over, or who directly or indirectly conduct the day-to-day
operation of an institution, organization, or agency. The term "managing employees" includes
any "agent" of the provider, which would include any person who has been delegated the
authority to obligate or act on behalf of the provider. All managing employees of the provider at
any of the provider’s practice locations must be reported in this section.

Please provide the following information of all managing employees, title, address, date of birth
(DOB), and SSN.

.owa Medicaid ! r.', i —C.U —
Portal Access = e

Eile » Review » Manage » Information » Messages Logout

Tax ID: 812
Application InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management TRz A12
2 Organizational Roster Management Name: R3E-SERIeR I L RanT 11C
3 Rendering Roster Management
4 Ownership And Control Disclosure Managing Employees
Provider Type 4
Federal requlations require that Medicaid agencies require providers to submit information about managing employees. The term
Managing Employees "managing employees” means a general manager, business manager, administrator, director, or other individuals who exercise
Ownership operational or managenial control over, or who directly or indirectly conduct the day-to-day operation of an institution, organization,
Individual or agency. The term "managing employees” includes any "agent” of the provider, which would include any person who has been
Non-Individual delegated the authority to obligate or act on behalf of the provider. All managing employees of the provider at any of the provider's
f Sut tract practice locations must be reported in this secticn.
Relationships Please provide the following information in the table below name of all managing employees, title, address, DOB, and SSN.
Individual
Non-Individual All fields are required. Adverse Action where applicable
Other Disclosing Entities
Final Adverse Actions RED
Patient Protection & ACA Person Name Title Address(es) DOB S5N Actions
5 Health Information Technology Survey Hew
6 IME Documentation Verification
7A and Acceptance
8 Renewal Package Review
Not applicable (N/A) - 1 attest that the information submitted is accurate and complete and that I have read this entire section
before submitting.
Next
Towa Dapartmant of Hunan Sarvices

e Click on New.
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Party for Managing Employees
You may enter a new party and then save it.

5 III
=—

e
" Firstome]
iadte Name]
Lot tome]
[ oote ot s
averse acions |8

Save Clear Close

e Enter the required information. All fields are required except the Middle Name and
Adverse Actions.

e Click on Save.

Party for Managing Employges
Party Name was saved.

B 123456789
el
e
o
o mame

[ ote of i [STVEE
n

Save Clear Close

e The graphic shown above displays a message when the record is saved successfully.
¢ Click on Close to return to the Managing Employee main page.
¢ Repeat until all managing employees appear in the grid.
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swa Medicaid
Portal Access

Good Afternoon

Tax ID: 312
Application Status: InProgress

Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management fandy 12
5 Name: 173 T e |
3 Rendering Roster Management
4 Ownership And Control Disclosure Wanaghig Employess
Provider Type : . _— " . - I~ ’ i
Federal regulations require that Medicaid agencies require p to submit ir about 19 employ The term
Managing Employees "managing employees” means a general manager, business f ini o di , or other individuals who exercise
Ownership operational or managerial control over, or who drectly or indirectly conduct the day-to-day operation of an institution, organization,
Individual or agency. The term "managing employees® includes any “agent” of the provider, which would include any person who has been
Non-Individual delegated the authority to obligate or act on behalf of the provider. All ging employ of the provider at any of the provider's
f Sul tract practice locations must be reported in this section.
Relationships Please provide the following information in the tzble below name of all managing employees, title, address, DOB, and SSN.
Individual
Non-Individual All fields are required. Adverse Action where applicable
Other Disclosing Entities
Einal Adverse Actions
Adverse
g Eatlent Protection & ACA Person Name Title Address(es) DOB SSN Actions
Health Information Technology Survey
g | | New
IME Documentation Verification T T
7 Agreement and Acceptance i
8 Renewal Package Review
= == o . ; 3 E = 3
Last , First Title | Addresses | 7/1/2015 113456789 Edit mk
i i

Not applicable (N/A) - I attest that the information submitted is accurate and complete and that [ have read this entire section
before submitting. ||

Ne-

To edit an existing row (prior to submission) click on Edit

To delete a row, (prior to submission) click on Delete. Once you delete a row you cannot get it
back.

Address information is required; The Address is shown in red font.

Addressesford *o= . tt S
v Gy

Cove

o Click on Addresses.
0 Click on New or if not new, click on Edit.
o0 Enter the required information. All fields are required except zip4. Also there is a
drop down list for the type of address.
e Click on Save, you will see a message that the record was saved successfully.
e Click on Close.
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e |f an additional address is needed, select New. If no additional address is needed, click
Close.

After addresses have been entered for each line, complete the attestation and click on next.

Individuals

Please list all INDIVIDUALS with an ownership or control interest in you. Include each person’s
name, address, DOB, SSN, and title and, the percent of ownership.

"Persons with an ownership or control interest” means-

e has an ownership interest totaling five percent or more in you;

e has an indirect ownership interest equal to five percent or more in you;

e has a combination of direct and indirect ownership interest equal to five percent or more
in you;

e 0owns an interest of five percent or more in any mortgage, deed of trust note, or other
obligation secured by the disclosing entity if that interest equals at least five percent of
the value of the property or assets of you;

e |s a partner in your organization if organized as a partnership.

Iowa Medicaid =

Portal Access WML » Good Afternoon

File » Review P Manage » Information *» Messages Logout

Tax ID: 812
Application Status: InProgress

Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management Tax ID: 812
2 Organizational Roster Management Mame: Lc
3 Rendering Roster Management
4 Ownership And Control Disclosure Individual
Provider Type
Managing Employees

Please list in the table below all individuals with an ownership or control interest in you. Include each persen's name, address(es),
date of birth (DOB), and SSN, title (e.g. chief executive office, owner, board member, etc.) and if an owner, the percent of

Ownership ownership.
Individual
Non-Individual "Persons with an ownership or control interest" means-
of Subcontractors X X
Relationships e has an ownership interest totaling five percent or more in you;
Relationships S
e e has an indirect ownership interest equal to five percent or more in you;
ndividua

has a combination of direct and indirect ownership interest equal to five percent or more in you;

Non-Individual owns an interest of five percent or more in any mortgage, deed of trust note, or other obligation secured by the disclosing

Other Disclosing Entities entity if that interest equals at least five percent of the value of the property or assets of you;
Final Adverse Actions « is an officer or director of your organization if you are organized as a corporation; or
Patient Protection & ACA e is a partner in your organization if organized as a partnership.

5 Health Information Technology Survey
6 IME Documentation Verification

7 Agreement and Acceptance Name of Ownership Adverse
8 Renewal Package Review Individual Title Percentage | Address(es) DOB SSN | Actions

All fields are required. Adverse Action where applicable.

Mo Data Found

Mot applicable (N/A) - I attest that the information submitted is accurate and complete and that I have read this entire section

before submitting. [ \
* Next

If there are no individual owners then you must attest to that fact and click on Next.
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owa Medicaid
Portal Access

Good Afterncon {

—

Tax ID: 812
Application Status: InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management Tax ID: 812
2 Organizational Roster Management Name: |50 : ooouc
3 Rendering Roster Management
4 Ownership And Control Disclosure Individual
Please list in the table below all with an or control interest in you. Include each person’s name, address(es),

Managing Employees date of birth (DOB), and S5N, title (e.g. chief executive office, owner, board member, etc.) and if an owner, the percent of
Ownership ownership.

Non-Individual "Persons with an ownership or control interest® means-

of Subcontractors

+ has an ownership interest totaling five parcent or more in you;
+ has an indirect ownership interest equal to five percent or more ir you;

Individual + has a combination of direct and indirect ownership interest equal to five percent or more in you;

Non-Individual « owns an interest of five percent or more in any mortgage, deed of trust note, or other obligation secured by the disclosing
Other Disclosing Entities entity if that interest equals at least five percent of the value of the property or assets of you;
Final Adverse Actions « is an officer or director of your organization if you are ized as a corporation; or
Patient Protection & ACA = is a partner in your organization if organized as a partnership.

All fields are required. Adverse Action where applicable.

Name of Ownership Adverse

Individual Title Percentage Address{es) DOB SSN Actions

No Data Found

Not applicable (N/A) - 1 attest that the information submitted is accurate and complete and that I have read this entire section
before submitting. [

Next

If there are individuals that meet this requirement then click on New.

Party for Individual

You may enter a new party and then save it.

e

e

T atvame]

Middle Name:||

 vostame]

Ownership Percentage: |

Date of Birth:|]
Adverse Actions: |l

Revised 11/2022
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¢ Enter the required information. All fields are required except the Middle Name and
Adverse Actions.

e Click on Save; you will see a message that the record was saved successfully.

e Click on Close.

_wa Medicaid
Portal Access

Good Afternoon

Tax ID: 312
Application Status: InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management T 10 P12
2 Organizational Roster Management Hame: EN - - LLC
3 Rendering Roster Management
4 Ownership And Control Disclosure Individual
Please list in the table belew all individuals with an ownership or control interest in you. Include each person's name, address(es),
Managing Employees date of birth (DOB), and SSN, title (e.g. chief executive office, owner, baard member, etc.) and if an owner, the percent of
Ownership ownership.
Individual
Non-Individual "Persons with an ownership or control interest” means-
of Subcontractors
Relationshi + has an ownership interest totaling five percant or more in you;
« has an indirect ownership interest equal to five percent or more in you;
Individual « has a combination of direct and indirect ownership interest equal ta five percent or more in you;
Non-Individual * owns an interest of five percent or more in any mortgage, deed of trust note, or other cbligation secured by the disclosing
Other Disclosing Entities entity if that interes: equals at least five percent of the value of the property or assets of you;
Einal Adverse Actions « is an officer or director of your organization if you are organized as a corporation; or
Patient Protection & ACA « is a partner in your crganization if organized as a partnership.
:H&ﬂﬂl e All fields are required. Adverse Action where applicable.
IME Documentation Verification
7 Agreement and Acceplance Name of Ownership Ad
8 Renewal Package Review Individual Title Percentage Address(es) DOB SSN  Ad
last, First  Title | 100, Addresses _141/1900 123456789 Edit Delete

Not applicable (N/A) - I attest that the information submitted is accurate and complete and that I have read this entire section
before submitting. |

Next

Iowa Department of Human Services

Addresses ford = el g

Gove

Addresses information is required; as shown above the Addresses is in red font

0 Click on Addresses
o Click on New or if not new, click on Edit
o Enter the required information. All fields are required except zip4. Also there is a
drop down list for the type of address
e Click on Save, you will see a message that the record was saved successfully.
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e Click on Close.
e |f an additional address is needed select New. If no additional address is needed, click
Close.

After addresses have been entered for each line, complete the attestation and click on next.

NON-INDIVIDUAL

Please list all corporations or other form of business entity with an ownership or control interest
in you. Include the TIN, the percent of ownership, the primary address, all business locations,
and P.O. Box address.

A corporation or other form of business entity is deemed to have an ownership or control
interest in you if it:

e has an ownership interest totaling five percent or more in you;

e has an indirect ownership interest equal to five percent or more in you;

e has a combination of direct and indirect ownership interest equal to five percent or more
in you;

e 0wns an interest of five percent or more in any mortgage, deed of trust note, or other
obligation secured by you if that interest equals at least five percent of the value of the
property or assets of you;

e Is an officer or director of you if organized as a corporation; or is a partner in you if
organized as a partnership.
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e —
owa Medicaid

Portal Access 9
Flle » Review » Manage » Information » Messages Logout
I ——

Tax ID:
Application Status: InProgress

Good Afternoon

Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management e ID:
2 Organizational Roster Management Pame:
3 Bendering Roster Management
4 Ownership And Control Disclosure ~ Non-Individual
Please list all corporations or other form of business entity with an ewnership or centrol interest in you. Include the TIN, the percent
Managing Employees of ownership, the primary address, all business lgcations, and P.O. Box address(es).
OQwnership
Individual A corporation or other form of business entity is deemed to have an ownership or control interest in you if it:
Non-Individual
of Subcontractors « has an hip interest ing five p or more in you;
Relationships + has an indirect ownership interest equal to five percent or more in you;
« has a combination of direct and indirect ownership interest equal to five percent or more in you;
Individual .

owns an interest of five percent or more in any mortgage, deed of trust note, or other obligation secured by you if that interest
Non-Individual equals at least five percent of the value of the property or assets of you;

Other Disclosing Entities » is an officer or director of you if organized as a corporation; or is a partner in you if organized as a partnership.
Einal Adverse Actions
Patient Protection & ACA All fields are required. Adverse Action where applicable.
5 Health Information Technology Survey
& Name of Ownership Adverse
2 IME Documentation Verification Business Entity Percentage Address(es) TIN Actions
Agreement and Acceptance New
8
Benewal Package Review

No Data Found

Not applicable (N/A) - I attest that the information submitted is accurate and complete and that I have read this entire section

before submitting. |
\ Next

Tows Dapartmant of Human Services

If there are no non-individual owners then you must attest to that fact and click on next.
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e —
owa Medicaid

Portal Access WL
file » Review » Manage » [nformation » Messages Logout

Tax ID:
Application Status: InProgress

Good Afternoon

Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management e ID:
2 Organizational Roster Management Name: PR —
3 Bendering Roster Management
4 Ownership And Control Disclosure ~ Non-Individual
Please list all corporations or other form of business entity with an ewnership or centrol interest in you. Include the TIN, the percent
Managing Employees of ownership, the primary address, all business lgcations, and P.O. Box address(es).
OQwnership
Individual A corporation or other form of business entity is deemed to have an ownership or control interest in you if it:
Non-Individual
of Subcontractors « has an hip interest ing five p or more in you;
Relationships + has an indirect ownership interest equal to five percent or more in you;
« has a combination of direct and indirect ownership interest equal to five percent or more in you;
Individual + owns an interest of five percent or more in any mortgage, deed of trust note, or other obligation secured by you if that interest
Non-Individual equals at least five percent of the value of the property or assets of you;
Other Disclosing Entities » is an officer or director of you if organized as a corporation; or is a partner in you if organized as a partnership.
Final Adverse Actions
Patient Protection & ACA All fields are required. Adverse Action where applicable.
5 Health Information Technology Survey
& Name of Ownership Adverse
7W Business Entity Percentage Address(es) TIN Actions
Agreement and Acceptance |
g New 4
Benewal Package Review

No Data Found

Not applicable (N/A) - I attest that the ir ion submitted is and ip and that I have read this entire section
before submitting. [

Next

lows Dapartmant of Human Sarvices

e Click on New.

Party for Non-Individual
You may enter a new party and then save it.

N: I|
[ usiness Nome
Ownership Percentage:

Adverse Actions: |l

Save Clear Close
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¢ Enter the required information. All fields are required except the Adverse Actions, only if
applicable.

e Click on Save. A message will be displayed in red when the record is saved.

e Click on Close to return to the Non-Individual Ownership main page.

owa Medicaid .
Good Afterncon
Portal Access
£lle » Review » Manage » Information » Messages Logout
Tax ID.
Application InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management Tax ID:
2 Organizational Roster Management Hame: ) uc
3 Rendering Roster Management -
4 Ownership And Control Disclosure Non-Individual
Erovider Type Please list all corporations or other form of business entity with an ownership or control interest in you. Include the TIN, the percent
Managing Employees of ownership, the primary address, all business locations, and P.0O. Box address(es).
Ownership
Individual A corporation or other form of business entity is deemed to have an ownership or control interest in you if it:
Non-Individual
of Subcontractors = has an ownership interest totaling five percent or more in you;
Relati hi # has an indirect ownership interest equal to five percent or more in you;
= has a combination of direct and indirect ownership interest equal to five percent or more in you;
Individual + owns an interest of five percent or more in any mortgage, deed of trust note, or other obligation secured by you if that interest
Non-Individual equals at least five percent of the value of the property or assets of you;
Other Disclosing Entities » is an officer or director of you if organized as a corporation; or is a partner in you if organized as a partnership.
Einal Adverse Actions
Patient Protection & ACA All fields are required. Adverse Action where applicable.
5 Health ion Technol Survey
& IME D — tation Verificati = Name of Ownership Adverse
> Business Entity Percentage Address{es) TI Actions
Agreement and Acceplance
< . . | New
Renewal Package Review
| b Addresses | | [Edit Delete
| Addresses | | Edit Delete
Addresses | = Edit Delete
Not applicable (N/A) - I attest that the information submitted is accurate and complete and that I have read this entire section
before submitting.
Next

Addresses for / °

Gove

Addresses information is required; as shown above the Address is in red font.

0 Click on Addresses

Click on New or if not new click on Edit

o0 Enter the required information. All fields are required except zip+4. Also there is a
drop down list for the type of address

o
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¢ Click on Save, you will see a message that the record was saved successfully.
e Click on Close.

e If an additional address is needed select New, if no additional address click Close.

After addresses have been entered for each line, complete the attestation and click on next.

Subcontractors

Please list all subcontractors in which you have an ownership interest of five percent or more.
Include the Tax Identification Number (TIN) or SSN, the percent of ownership, the primary
address, all business locations, and P.O. Box address.

owa Medicaid -
Portal Access & B

File » Review » Manage » Information » Messages Logoul

Tax ID: 812
Application Status: InProgress

Home Ownership and Control Disclosure
Process Checkout/Checkin

1 Business Entity Management TacTD: F12

2 Organizational Roster Management Wamas Lo

4 Ownership And Control Disclosure of Subcontractors

Provider Type .
Please list all subcontractors in which you have an ownership interest of five percent or more. Include the TIN or SSN, the percent of
Managing Employees ownership, the primary address, all business locations, and P.O. Box address(es).
Ownership
Individual All fields are required. Adverse Action where applicable.
Non-Individual
of Subcontractors Hame ol =8 O nership Adverse
Business Entity Percentage Address{es) TIN Owners Actions
Relationships
Individual New
Non-Individual No Data Found
Other Disclosing Entities
Einal Adverse Actions Not apphicable (N/A) - I attest that the information submitted s accurite and complete and that 1 have read this entire section
Patient Protection & ACA Batdes s bmitti, \
5 Health Information Technology Survey Next
6 IME Documentation Verification
7 Agreement and Acceptance
8 Renewal Package Review

lews Departmant of Human Services

If there are no subcontractor owners then you must attest to that fact and click on Next.

Revised 11/2022 Page 27



If there are subcontractors that meet this requirement then enter new rows as appropriate.

.owa Medicaid
Portal Access

A

Good Afternoon

Eile » Review *» Manage » [nformation » Messages Logout

before submitting. [

Tax ID: 812
InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management Tax 10 B2
2 Organizational Roster Management ame: L
3 Rendering Roster Management
4 Qwnership And Control Disclosyrg  ©f Subcontractors
Provider Type ; . i
Please list all subcontractors in which you have an P of five p or more. Include the TIN or SSN, the percent of
Managing Employees hip, the primary address, all business locations, and P.O. Box adiress(es).
Ownership
Individual All fields are required. Adverse Action where applicable.
Non-Individual
of Subcontractors Name of Ownership Advers
Business Entity Percentage Address(es) TIN Owners Actio
Relationships
Individual Nen' —
Non-Individual No Data Found
Other Disclosing Entities
Final Adverse Actions Not applicable {N/A) - 1 attest that the information submitted is accurate and complete and that I have read this entire section

Next

lewa Dapartmant of Human Sarvicas

e Click on New.
e Enter the required information.

Party for of Subcontractors
You may enter a new party and then save it.

—

" ousiness Nome
Ownership Percentage: |

Adverse Actions: |l

Save

Revised 11/2022
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Party for of Subcontra

cto
Party Name was saved.

Ownership Percentage: |20
Adverse Actions: |l

Save Clear Close

¢ Allfields are required except the Adverse Actions.
¢ Click on Save, a message will be displayed in red when the record is saved.
e Click on Close to return to the Subcontractor main page.
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-wa Medicaid
Portal Access

Good Afternoon

Tax ID: 812
Application Status: InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management Tt N
2 Organizational Roster Management Name: I - LLC
3 Rendering Roster Management
4 Ownership And Control Disclosure W SubcOEALtorS
Please list all subcontracters in which you have an ownership interest of five percent or more. Include the TIN or SSN, the percent of
Managing Employees ownership, the primary address, all business locations, and P.O. Box address(es).
Ownership
Individual All fields are required. Adverse Action where applicable.
Non-Individual
of Subcontractors -
Name of ownership Al
Relationships Business Entity Percentage Address(es) TIN Owners
Individual | New
Non-Individual - ! 1 | | | ne! |
Other Disclosing Entities Business Name | 20 Addresses 111111111 9—“—'—‘3!5“ [Edit Delete

Mot applicable (N/A) - 1 attest that the informaton submitted is accurate and complete and that I have read this entire section
before submitting. [

Next

T ——

¢ Address information is required as with prior sections.
e Owners are required to be listed.

~whnership of Controlling Interests
for Business Name

Adverse
Business Name DOB SSN/TIN Actions

No Data Found /

Close
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e Click on New

Party for Ownership of Controlling Interests
You may enter a new party and then save it.

1115 Person v &
Tax ID/SSN: |

" Festane]
Middle Name:||
— weons]

Date of Birth:|

Adverse Actions: il

Save Clear Close

Party for Ownership of Controlling Interests
You may enter a new party and then save it.

Tax ID/SSN: |
Business Nome]

Adverse Actions:I B

Save Clear Close

e Select Person or Organization from the drop down.

e Enter the required information, all fields are required except Adverse Actions.

¢ Click on Save, again you will see the message that the record was saved successfully.
e Click on Close.

¢ Click on Close again to return to the main record.

¢ If no additional information, complete the attestation and click on Next.
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Relationships

If you listed any individual owners of you, are any of the individual owners related to each other
as a spouse, parent, child or sibling? Yes or No.

If you answered “yes” continue.

If there are no individual relationships then you must attest to that fact and click on Next.

.owa Medicaid
Portal Access

Good Afternoon I

Tax ID: B12
Application Status: InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management TH 1D A2
- Name: BN E LLC

3 Rendering Roster Management

4 Individual Relationships
If you fisted any individual owners of you, are any of the individual owners related to each other as a spouse, parent, child or sibling?
Yes or |_|No
Ownership
Individual
Non-Individual 1f you answered yes: Please provide all of the following information about each individual owner in the table below.
of Subcontractors
Relationships All fields are required.
Individual Nameof
Non-Individual Individual Title Relationship DOB SSN
Einal Adverse Actions No Data Found
Patient Protection & ACA
s Not applicable (N/A) - I attest that the information submitted is accurate and complete and that I have read this entire section
:mzmmmmmnmnm bafore submitting, Bl
Agreement and Acceptance
8 Renewal Package Review

Next

lowa Departmant of Huran Services

¢ Answer the yes or no question.
e If you answer yes you must enter the name (s) in grid.

e Click on New.

Revised 11/2022
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Party for Individual Relationships
You may enter a new party and then save it.

Middle Name:|

ot vame]

oot o ]

Save

Clear

Close

Enter the required information; all fields are required except the Adverse Actions.

Click on Save.

Click on Close to return to the Individual Relationship main page.

Revised 11/2022
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sowa Medicaid Good Afternoon
Portal Access <
Eile » Review » Manage » [nformation » Messages Logout
EESS————S——————————————————————.— —————————
Tax ID: vomeesg 12
Status: InProgress

Home Ownership and Control Disclosure
Process Checkout/Checkin

1 Business Entity Management T 812

2 Organizational Roster Management Name: s

4 ownership And Control Disclosure Individual Relationships

Provider Type .
If you listed any individual owners of you, are any of the individual owners related to each other as a spouse, parent, child or sibling?
Yes or [ [No
Ownership
Individual
Non-Individual If you answered yes: Please provide all of the following information about each individual owner in the table below.
of Subcontractors
Relationships All fields are required.
Individual Nama of
Non-Individual Individual Title Relationship DOB S5M
Einal Adverse Actions last , First |owner Relationships 1/1/1900/111111111 Edit Delete
i i L 19! L Lt/ Aty

Not applicable (N/A) - I at at the information submitted is accurate and complete and that I have read this entire section
before submitting. ||

Next

¢ Click on Relationships.

Relationship for last , First
Name of
Individual Relationship DOB SSN

No Data Found

Close

e Click on New.

Revised 11/2022 Page 34



-arty for Individual Relationships
You may enter a new party and then save it.

BEEIGLEITE Brother -
Middle Name:||
oote of pien]

Save Clear Close

e Select the type of relationship from the drop down.

e Enter the required information; all is required except Middle Name.

e Click on Save, again you see the message that the record was saved successfully.
e Click on Close.

¢ Click on close again to return to the main record.

e If there is no additional information, complete the attestation and click Next.
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Non-Individual and Subcontractor Relationships

If you listed any individual owners of you and also listed any subcontractors in which you have
an ownership interest, are any of the individual owners previously listed related to any owner of
any subcontractors as a spouse, parent, child or sibling?

If there are no non-individual or subcontractor relationships then you must attest to that fact and

click on Next.

.owa Medicaid ‘ —
Portal Access = | Sood Afterno

File » Review » Manage * [nformation » Messages Logout

Tax ID: 812
Application Status: InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management Tax 1 812
2 Organizational Roster Management Name: L
3 Rendering Roster Management
4 Ownership And Control Disclosure Non-Individual and Subcontractor Relationships
Provider Type
If you listed any individual owners of you and also listed any subcontractors in which you have an ownership interest, are any of the
Managing Employees
individual owners previously listed related to any owner of any subcontractors as a spouse, parent, child or sibling? | Yes or [ |No
Ownership
Individual
Non-Individual If you answered yes: Please provide all of the folowing information about each individual owner in the table below.
of Subcontractors
lationshi All fields are required.
Individual
Non-Individual Name of Ownership
Other Disclosing Entities Business Entity Percentage Relationship TIN
Einal Adverse Actions New
Patient Protection & ACA No Data Feund “.
5 Health Information Technology Survey
6 IME Documentation Verification
7 Agr and A [ Not applicable (N/A) - I attest that the information submitted is accurate and complete and that I have read this entire section
8 Renewal Package Review before submitting.
Next
Towa Daparvmant of Human Services

If there are individual relationships that meet this requirement then enter new rows as

appropriate.

¢ Answer the yes or no question, if yes.

e Click on New.

Revised 11/2022
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Party for Non-Individual and Subcontractor Relationships
You may enter a new party and then save it.

—

Business Name:||

Ownership Percentage: I—
Adverse Actions: |l

Save Clear Close

e Enter the required information; all fields are required except the Adverse Actions.
¢ Click on Save, a message will be displayed when the record is saved.
e Click on Close.

Jswa Medicaid
Portal Access y y
file *» Review » Manage * Information » Messages Logout

Good Afternoon

Tax ID: 812
Application InProgress
Home Ownership and Control Disclosure
Process Checkout/Checkin
1 Business Entity Management Ry 12
2 Organizational Roster Management Name: S e
3 Rendering Roster Management
4 Ownership And Control Disclosure Non-Individual and Subcontractor Relationships
If you listed any individual owners of you and also listed any subcontractors in which you have an ownership interest, are any of the
individual owners praviously listed related to any owner of any subcontractors as a spouse, parent, child or sibling? _|Yes or | [No
Ownership
Individual
Non-Individual 1f you answered yes: Please provide all of the folowing inf ion about each individual owner in the table below.
of Subcontractors
Relationships All fields are required.
Individual
Non-Individual Name of Ownership
Other Disclosing Entities Business Entity Percentage Relationship TIN
Patient Protection & ACA Name | 50 Relationships 387654321 Edit Delete
5 Health Information Technology Survey
6 IME Documentation Verification
7 Agreement and Acceplance Not applicable (N/A) - 1 attest that the information submitted is accurate and complete and that I have read this entire section
8 Renewal Package Review before submitting. [
Next
Towa Dapartmant of Hurman Services
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¢ Click on Relationships.

Relationship for Name
Name of
Business
Entity Relationship TIN

No Data Found

Close

e Click on New.

Party for Non-Individual and Subcontractor Relationships
You may enter a new party and then save it.

G RGBT Brother -
o
business Nome

Save Clear Close

e Select the Relationship from the drop down.

¢ Enter the required information.

¢ Click on Save, a message will be displayed when the record is saved successfully.
e Click on Close.

e Click on Close again to return to the main record.

If there is no additional information, complete the attestation and click Next.
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Other Disclosing Entities

Do any owners of you have an ownership or control interest in any "other disclosing entity"?
This means, do any of your owners have an ownership or control interest in any other
organization that would qualify as a "disclosing entity." "Other disclosing entity" means any other
Medicaid disclosing entity and any entity that does not participate in Medicaid, but is required to
disclose certain ownership and control information because of participation in any of the
programs established under Title V, XVIII or XX or the Act. This includes:

Any hospital, skilled nursing facility, home health agency, independent clinical laboratory, renal
disease facility, rural health clinic, or health maintenance organization that participates in
Medicare (title XVI11):

e Any Medicare intermediary or carrier; and

e Any entity (other than an individual practitioner or group of practitioners) that furnishes,
or arranges for the furnishing of, health-related services for which it claims payment
under any plan or program established under Title V or Title XX of the Act.

Whereas "disclosing entity" is limited to Medicaid provider, "Other disclosing entity" can include
entities that are not enrolled in a Medicaid program.

If this section is not applicable, please attest to that fact and click on next.

List the name of each owner of you who has such interest and the name of the other disclosing
entity in which the owner has an ownership or control interest in:

e Click on New.

All fields are required. Adverse Action where applicable.

. Name of Other Adverse
Business Name Disclosing Entity Actions

New ‘
No Data Found ‘
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e Select type from the drop down
o Organization or person

B e R e e P P S P p'

Party for Other Disclosing Entities
You may enter a new party and then save it.

 tvee]orgamzatonS .c

ousinss ame] k
Adverse Actions: Il tk

fe

I, .

—l

-

W e

Save Clear Close y

W

ke

Party for Other Disclosing Entities
You may enter a new party and then save it.

TR —-
i hame] :
" iad name |
Lot ame] r—
avere ncions |8 "

Save Clear Close

R

All fields are requried.

e Click Save.
e Once saved, click close.
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Name of other disclosing “Entity.”

e Click on Entity.

Name of Other | Adverse
Business Name Disclosing Entity Actions

I | New

| Entity \ v Edit Delete |

e Select type from the drop down.
o Organization or person

B R S L FEIR I I M E Y W M ey

B bl

Party for Other Disclosing Entities

You may enter a new party and then save it. -
T T —— :
business Rame | I

rar

B ——

e

Save Clear Close

e
-

fprogrant. [
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Party for Other Disclosing Entities F

You may enter a new party and then save it.
e |
|_First Name:| I
Middle Name:||

)

Lot vame

Save Clear Close

] ] L] (h] r L] r L} L} 1 =

All fields are requried.

e Click Save.
e Once saved, click close.

If there is no additional information, complete the attestation and click Next.
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Final Adverse Actions

This section captures information on "Final Adverse Actions," such as convictions,
exclusions, revocations, and suspensions. All applicable final adverse actions must be
reported, regardless of whether any records were expunged or any appeals are pending.
Enrolled providers are required to report all Final Adverse Actions/Convictions within 30
days of the reportable event.

For all individuals or entities listed in any of the pervious tables, as well as the provider
submitting this application, provide all information required below for any individual or
entity that has been the subject of a Final Adverse Action.

Report each final adverse action, when it occurred, the federal or state agency or the
court/administrative body that imposed the action, and attach the resolution, if any.

All fields are required. Adverse Action where applicable.

Date of Final
Individual/Buiness Taken By Adverse Action| Resolution

o . , Resolutions Edit
— | | Resolutions Edit

e Click on Resolutions.

Adverse Action Detail for

Entity Type Resolution [

Ne

No Data Fouhd ‘

e Click on New.
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Adverse Action Detail for

Resolution:

ey JvRe: v

w

Save Clear Close

Type in the resolution.

Click save.

If more than one adverse action, click new and repeat.
After all resolutions have been saved click on close.

Repeat for each individual/business listed in the grid.

If there is no additional information, complete the attestation and click Next.

Revised 11/2022
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Patient Protection and Affordable Care Act (ACA)

Please answer all five questions for each individual/business listed in the grid.

Note: Known issue- names are repeat multi times, each time a person or organization is
entered in a previous section the name will appear in the grid. Example if you entered the same
individual as managing employee, owner and relationship sections that same name will appear
in the grid for each entry (3 times). You must click on the “program integrity details” for each row
and answer the questions before you can complete this section.

e Click on “Program Integrity Details.”

azation and Control Disclosure

Patient Protection and Affordable Care Act
Please answer all five (5) questions:

"Does the provider applicant have any current or previous direct or indirect affiliation (as defined below) with
Medicaid provider?

The term "affiliation" includes but is not limited to relationships between individuals, business entities, or a cor
The term includes direct or indirect business relationships that involve

(1) a compensation arrangement,

(2) an ownership arrangement,

(3) managerial authority over either member of the affiliation,

(4) the ability of one member of the affiliation to control the other, or

(5) the ability of a third party to control both members of the affiliation.

SSN/TIN Individual/Business  Program Integrity Detail Comple

STTTTTN6 riveTiy; juliE Program Integrity Details o
| Program Integrity Details Ll
|€ Program Integrity Details Cl

: L & ' Program Integrity Details C]

Not applicable (N/A) - I attest that the information submitted is accurate and complete and that I have rez
before submitting. [

e Click on Attestation.
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Attestation Status

| Organization/Person Name Uncollected Debt  Payment Suspension Billing Denied  Excluded Shares NPI with Uncollected Debt  Attestation
| No No |Not Answered |Not Answered Not Answered Attestation
| ‘

Answer each question (Yes, No or Not Sure) click next.

Has uncollected debt owed to Medicaid or any other health care program
funded by any governmental entity, including but not limited to the federal
and Iowa governments,

OYes
@® No
(O Not Sure
Next Close
'I-III!IUI '"'“'ﬂ" e IW’:_ =r— ..I
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Aas been or is subject to a payment suspension under a federally-funded
health care program

OYes
@® No
(O Not Sure

Next Close
Has had i!;g_billing privileges denied or revoked
Oles
ONo
(O Not Sure
Next Close
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Has been excluded from participation under Medicaid, Medicare, or any
other federally-funded health care program

(O Not Sure

Next Close

lemith  Aaciraca Dranram Tntanribv Natailc T

Shares a National Provider Identifier (NPI) number or Federal Tax
Identification number with another provider who has uncollected debt

Olves
ONo
() Not Sure
Next Close
 prpe——.y s [P p—— [, TeRS————— ity Sp—— ] S gy wp—" | (- | |

o After all five questions are answered, click on Close and repeat until all lines have been
checked completed.

If there is no additional information, complete the attestation and click Next.
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Once all sections of the Ownership and Control Disclosure are completed return to
section 4 by clicking in the navigation section.

Tax ID: «
Application Status: InProgress

Home Ownership and Control Disclosure Check-out History

Check In ‘

4 Ownership And Control Disclosure (s 15, 1p: =
Provider Type Current Status: InProgress

5 Health Information Technology Survey

6 IME Documentation Verification

7 Agreement and Acceptance Ready to Complete

8 Renewal Package Review

Next

Click on Ready to Complete

You must check the attest box and click Submit.

Tax ID:
application Status: InProgress

Home Ownership and Control Disclosure Check-out History
1 Business Entity Management )
2 i ) ) Check In

4 Ownership And Control Disclosure Tax ID:
Provider Type Current Status: InProgress

7 Agreement and Acceptance THE PROVIDER CERTIFIES THAT THE INFORMATION SUBMITTED ON THIS FORM IS, TO THE BEST OF THE PROVIDER'S KNOWLEDGE,

& Renewal Package Review TRUE, ACCURATE AND COMPLETE AND THAT THE PROVIDER HAS READ THIS ENTIRE FORM BEFORE SIGNING. THE PROVIDER ALSO
UNDERSTANDS THAT PAYMENT OF CLAIMS WILL BE FROM FEDERAL AND STATE FUNDS AND THAT ANY FALSIFICATION OR

CONCEALMENT OF A MATERIAL FACT MAY BE PROSECUTED UNDER FEDERAL AND STATE LAW

I attest that the information submitted is accurzte and complete and that I have read this entire section before submitting. [ ‘

[ Submit

Next
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Section 5: HIT Survey

This section is optional

Thank you for reenrolling as a provider with lowa Medicaid. In our continuing efforts to gauge
provider adoption of electronic health records (EHR), we request that you complete the following
short survey regarding your usage of EHR. Your responses greatly improve our planning efforts
for health information technology.

e Answer each section and click next

Do you currently use electronic health records (EHR)?

[]Yes [] No

Start Over Previous Next

Do you intend to purchase an EHR?
No

Yes, within 1 year
Yes within 3 years

oooao

Yes within 5 years

Start Over Previous Next
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The last year in which to enter the Medicaid Electronic Health Records Incentive Program is the
2016 program year. Do you plan to participate in the Electronic Health Records Incentive Program
(Meaningful Use)?

[ Yes

[] No

[T] No, not eligible

["] No, not enough info

Start Over Previous Next

~hat are your primary barriers for using an EHR (check all that apply)
[ N/A
[[] Cost
[ ] Confusing
[[] staff does not have the training/knowledge to use an EHR
[T] EHR unable to interface with other systems
[] Decreased productivity during implementation
[[] Concern that EHR will quickly become obsolete
[7] Lack of technical support
[] Not able to find a solution that fits my data and workflow needs
[] privacy and security
[] Liability
[7] satisfied with current system
[] Retiring within the next 3 years
[[] Access to broadband (high-speed internet)

Other

Start Over Previous Next
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Electronic Clinical Quality Measures (eCQMs) use data from electronic health records (EHR) and/or

health information technology systems to measure health care quality within the healthcare
it InTormaton tecnnoiogy systems 1 measu health car Quaily witnin O neaincare

delivery system. They are defined, maintained, and updated in order to produce standardized
measures to make collection, use, and comparisons easier. Measuring and reporting eCQMs helps to
make sure that care is delivered safely, effectively, equitably, and timely. eCQMs are used today
with several Medicare programs including MSSP (Medicare Shared Savings Program), PQRI
(Physician Quality Reporting Initiative) and MU (Meaningful Use).

Would you be interested in submitting eCQMs to the IME which could be linked to payment
incentives?

[7] Yes
[] No

Start Nuar Dravinne MNawt

Are you connected to the Iowa Health Information Network (IHIN)?
[] Yes, Query functionality

[] Yes, Direct Secure Messaging

[] Yes, Electronic Lab Reporting (smartlab)
[] Yes, Cancer Reporting (cancer registry)
[] No, but plan to with 1 year

[] No, but plan to within 2-3 years

[] No plans to exchange information

Start Over Previous Next

Are you connected to a Health Information Exchange? (excluding the IHIN)
[] Yes

[] No

Start Over Previous Next
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What can Medicaid do to assist you in the adoption and meaningful use of electronic health

records? (Check all that apply)
[] Identify products

[] Provide technical assistance for product selection

[] Provide technical assistance for implementation

[[] Connect me with similar providers who have adopted EHR for information
[] Share best practice information

Other

Start Over Previous Next

~lease select your provider type.

[] Adult Rehab [] Audiologist

[[] Behavioral Health [[] Certified Nurse Midwife

[] Chiropractor [] clinical Social Worker

[] CRNA [] Dentist

[C] Family Planning [] Habilitation Services

[] Independent Speech Pathologist [ ] Indian Health Service

[] Maternal Health Center [[] SPMI SED Provider

[] Medical Supplies [] Mental Health Substance Abuse Plan
[] MEP Case Manager [ n/A

[] Nurse Practitioner [] Occupational Therapist

[] Optician [] Optometrist

[[] other Practitioner - General [7] Para Professional

[] Pharmacy [] Physical Therapist

[] Physician Assistant [] Physician DO

[] Physician MD [] Podiatrist

[] Psychologist [] Therapeutic Treatment Service

Start Over Previous Next
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« Is your specialty?
[] Addiction Medicine
[] Ambulance

[[] Anesthesiology
[T] cardiovascular
[] Critical Care

[] Dermatology

[] Endodontics

[] Gastroenterology
[[] General Surgery
[[] Gynecological

[] Hematology

[] Indian Health Service Facility

[7] Internal Medicine
["] Medical Oncology
["] Neuro Surgery

[[] Neuropsychiatry
[T] Nuclear Medicine
[T] Oncology

[] Optometry

[] ortho Surgery

[] otolaryngology
[] pathology

[[] Pedontist

[] Physical Medicine Rehab
[] Plastic Surgery
[] Portable Xray

[7] Proctology

["] Pulmonary

[] Rheumatology

[] Urology

_1 Allergy

_| Anesthesiologist Assistants
] Cardiac Surgery

] Chiropractic

_] Dentist

_] Endocrinology

] Family Practice

| General Practice

_1 Geriatric Medicine
_] Hand Surgery

] Independent Lab

] Infectious Disease
] Maxillofacial Surgery
] Nephrology

_] Neurology

_I N/A

] OB/GYN

] ophthamology

] Oral Surgery

_] orthodontist

_] Pain Management
| Pediatrics

1 Periodontics

_] Physical Therapy
_] Podiatrist

_ 1 Preventive Medicine
] Psychiatry

] Radiology

_] Thoracic Surgery
_1 vascular Surgery

Start Over Previous Next
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HIT Contact Person Information
Name|

Addressl

Phone|

Emaﬂ|

Start Over Previous Next

Survey Completed
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Section 6: IME Documentation Verification
This section will be completed after you complete section 7.
Section 7: Agreement and Acceptance

This section can only be completed by the signatory user. If you are only the enroliment user
you will not be able to attest and accept the provider agreement.

Tax ID:
application Status: InProgress

Home Agreement and Acceptance Check-out History

2 Or P | Roster ~ | Check In
3 Rendering Roster Management Tax ID: =
4 Ownership And Control Disclosure Current Status: InProgress

{1 attest that ALL the information in the reenrcliment package section 1 through section 6 is complete and accurate,

7 Agreement and Acceptance 1 have read the below document(s) and understznd that by continuing, I am the responsible persen with powers to bind my
8 Renewal Package Review organization.

* Provider Agreement

Electronically Sign Renewal Data and IME Provider Agreement

] 1 am the Provider Signatory
L) I accept the Provider Agreement

A link to the provider agreement is located in the middle of the page for review.
After review the user must attest that all pervious section are complete and accurate.

Check both boxes.

e | am the Provider Signatory.
e | accept the Provider Agreement.
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Once all three boxes are checked Submit and Check-In will appear.

WI1 attest that ALL the information in the reenrollment package section 1 through section 6 i

I have read the below document(s) and understand that by continuing, I am the responsible |
organization.

e Provider Agreement

Electronically Sign Renewal Data and IME Provider Agreement

I am the Provider Signatory
I accept the Provider Agreement

Submit and Check-In \K

e Click on Submit and Check-In

Note: All pervious sections must be completed and checked-in. If not, you will receive and
error message and the “l accept the Provider Agreement” will be unchecked.

Once all sections have been completed and checked-in, click on the Agreement and
Acceptance link. Check out of edit and re-attest, and accept the provider agreement.
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Section 6: IME Documentation Verification

This section will be completed after you complete section 7.

Click on Generate Documents.

Tax ID: i

Application Status: InProgress

Home IME Documentation Verification
Process Checkout/Checkin
1 Business Entity Management
2 Organizational Roster Management
3 Rendering Roster Management
4 Ownership And Control Disclosure

Tax ID: 4
Current Status:

Provider Type Generate Documents
5 Health Information Technology Survey

6 IME Documentation Verification

7 Agreement and Acceptance
8 Renewal Package Review

Print provider reenrollment coversheet.

If no documentation is required as message will display.

If documentation is required a checklist of requirements will be displayed.
Application status will change to Submitted.

Attach documents to coversheet and mail to the IME.

The IME will verify documents received and application status on IMPA will change to
Complete.
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Section 8: Renewal Package Review

This section is view only.

Iowa Medicaid
Portal Access

Eile » Review » Manage » Information » Messages Logout

Good Afternocn ¢

Tax ID:
Application Status: ©
Home Enroll R | Package Revi v
- mmm:ﬁn Tax ID:
ZCioaaitd s Nt RN
3 Rendering Roster Management ; g Loy ¢ bt —agmmont TRRESEOANTY Administrator
4MMWEHI ..._...“.__...‘-B:S“"" -3 -51, el At :f““““‘ .Enmllmentuser .
| -j:".:.'.'.: e S e — 3 .Enrollment User
: L e £ [ k : Signatory
Business Entity Management Completed Smmihlae s 5/26/2016 11:54:49 AM
Organizational Roster Management [ Completed . (b . 5/26/2016 11:54:49 AM |
dering Roster [ Completed | LaeieE; [ 5/26/2016 11:54:49 AM |
Ownership and Control Disclosure . Completed . ' 5/26/2016 11:54:49 AM '
Health Information Technology Survey . Completed . == . 5/26/2016 11:54:49 AM |
Agreement and Acceptance [ Completed | mabiad [ 5/26/2016 11:54:49 AM
IME Documentation Verfication [ Completed . B = . 5/26/2016 11:54:49 AM |
Towa Department of Human Services

This section allows the user to view:

e The users and the role assigned to that user.
e Each section status, completed by and completed date.
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